
Introduction

In linguistics of the end of XX – the beginning of XXI centuries there is the special interest to the advertising as the discourse type. The creative potentiality of advertising as a discourse type has been pointed out recently by a lot of authors. Unfortunately you can not find a lot of papers devoted to the on-line advertising. The main explanation of this, in my estimation, is that on-line advertising is quit new type of promotion, but it gained tremendous success in last years.
Online advertising is a form of promotion that uses the Internet and World Wide Web for the expressed purpose of delivering marketing messages to attract customers. Examples of online advertising include contextual ads on search engine results pages, banner ads, Rich Media Ads, Social network advertising, online classified advertising, advertising networks and e-mail marketing, including e-mail spam.
The topicality of the paper is determined by necessity of the detailed analysis of the methods and types of the on-line advertising, their linguistic peculiarities and the creation of the web-site with the specific features of these advertisements and banners.
The research object is the on-line advertising and its use in the World Wide Web.
The research subject is the analysis of the lexically-semantic features of the advertising in the World Wide Web.
The aim of the paper is to find and describe the verbal and nonverbal methods that are used in advertising.
Among the objectives of this work are:
1) to describe persuasion methods, types and techniques of the on-line advertising;
2) to analyze different forms of advertising and point out why on-line advertisements has become so popular in last decades;
3) to outline the main types of banners;
4) to create a Web site with additional information about advertising and the examples of different banners.
The research is carried out with the help of the following methods of investigation:
· The descriptive method is used for full and precise description of the peculiarities of the on-line advertising.
· Due to the component analysis of the structural method I managed to describe the structure of banners and their location in web pages.
Labours of some philosophers, sociologists, psychologists, historians and linguists are devoted to the study of advertising (Semino, Cook, Campos Pardillos). At the same time on-line advertising (especially, banners) remains not fully investigated from linguistic positions. So, this is the novelty of the paper.
Practical value of diploma consists in possibilities of using its results in estimating what types of the advertisements will be the most useful. Positions of work can find practical application among managers and persons who promote different products.
The material, which is used while studying the theme, includes:
· books and researches on discourse and advertising;
· journals and papers related to the theme;
· internet sources;
· banners.
Web-site was created with Dremweaver software. Being new to web site building I had fixed upon this program because Dreamweaver is the best tool for both the beginning and advanced web page creator to create slightly complex website, with simple but animated toolbars, little animations, sound clips and so forth.

I. 
Linguistic peculiarities of the web-advertising

1. Main approaches of the persuasion

1.1 Discourse studies in modern linguistics
Discourse (L. discursus, "running to and from") means either "written or spoken communication or debate" or "a formal discussion or debate" . The term is often used in semantics and discourse analysis.
In semantics, discourses are linguistic units composed of several sentences; in other words, conversations, arguments, or speeches. In discourse analysis, which came to prominence in the late 1960s, the word "discourse" is shorthand for "discursive formation", which is what Michel Foucault called communication that involves specialized knowledge of various kinds. It is in this sense that the word is most often used in academic studies. [9, p.11]
Studies of discourse have been carried out within a variety of traditions that investigate the relations between language and structure including feminist studies, anthropology, ethnography, cultural studies, literary theory and the history of ideas. Within these fields, the notion of discourse is itself subject to discourse, that is, debated on the basis of specialized knowledge. Discourse can be observed in the use of spoken, written and signed language and multimodal/multimedia forms of communication, and is not found only in 'non-fictional' or verbal materials. [29 p.54]

1.2 The use of implication in the discourse of commercial English advertising
The thesis focuses on the problem of implication in the discourse of commercial English advertising. In this study under implication is understood a special way of expressing information that does not receive direct verbalization and is indicated by explicit verbal and nonverbal elements – markers. The explication of implicit information is achieved through additional mental operations. Evaluations and associations in the advertising discourse fall under the category of implicit information. The investigation has proved that implication is a distinguishing feature of the advertising discourse, tracked on the discourse, lexical, grammatical and nonverbal levels. The presence of implication is conditioned by the type of discourse, its parameters, aims and tasks of its sender. The status of implication in the advertising discourse is explained by its contradictory nature. On the one hand, implication complicates and hinders the processing and decoding of information, requires additional mental efforts of addressee, and, on the other hand, encourages addressee to take a more active part in the communication. Among the factors which stipulate implication in the advertising discourse are the principle of language economy, originality and expressiveness of language forms, tendency towards colloquialization of the advertising language, strengthening of illocutionary force. It has been shown that explicit presentation of information tends to be obtrusive whereas implicit way foresees drawing the addressee into more intensive decoding of information, increases attractiveness of advertising and its effects on the addressee. The structure of the cognitive model of the advertising discourse consists of motives and inducements and can be explicit or implicit. The implication of the inducement helps sender to avoid being categorical. The discourse of advertising is characterized by complex intentions. The indication of implication is realized by different types of discourse, lexical, grammatical and nonverbal markers. The decisive role in explication of implicit information belongs to the cognitive meaning of the advertising discourse. The implicit information, which is marked by explicit verbal and nonverbal means is part of the cognitive model, evaluation component, pragmatic meaning of text and word. The representation of the cognitive model can be complete or partial, which depends on the explicit or implicit rendering of its parts. The investigation has proved that it is partial representation of the cognitive model that dominates in the discourse of commercial English advertising.[5, p.234]
The category of evaluation, obligatory in the advertising discourse, is reflected in lexis, being part of the connotative component. The evaluation, which is present in the motive of the cognitive model, implies inducement, confirming its status of the regulator of the addressee’s behaviour. The evaluation in the discourse of commercial advertising is polyreferential. Among lexical markers of implicit information are place names, particles such as only, even, finally, at last, dates, the definite article, foreign words, quotations, comparative constructions. Imperative illocutionary force in the discourse of commercial advertising is realized by various grammatical markers, which mitigate the categorical modality of the text, create an impression of the sender’s non-engagement. Among grammatical markers stands out a group of questions, which within the advertising discourse loses its primary function, acquiring the meaning of inducement. Text of advertising is a bilingual unit, in which language and paralanguage fulfill one communicative task. Implicit information is marked by nonverbal means, namely illustrations, pictorial tropes, colour, underlining, kinds and size of type. Besides its attractiveness and psychological effect, colour is a marker of implicit information, which communicates to the addressee information about products and their high quality. Among paragraphic markers of implicit information underlining is applied to the most important elements of the text. Different styles of types were registered as nonverbal markers if implicit information about products advertised in the text. [11, p.58-60]

1.3 Types of persuasion in the everyday life
Persuasion is a form of social influence. It is the process of guiding people and oneself toward the adoption of an idea, attitude, or action by rational and symbolic (though not always logical) means. It is a strategy of problem-solving relying on "appeals" rather than coercion. According to Aristotle, "Rhetoric is the art of discovering, in a particular case, the available means of persuasion."
Everyday we are confronted by persuasion. Food makers want us to buy their newest products, while movie studios want us to go see the latest blockbusters. Because persuasion is such a pervasive component of our lives, it is easy to overlook how we are influenced by outside sources. [27]

1.3.1 Persuasion Techniques
Due to the usefulness of influence, persuasion techniques have been studied and observed since ancient times, but social psychologists began formally studying these techniques early in the 20th-century. The goal of persuasion is to convince the target to internalize the persuasive argument and adopt this new attitude as a part of their core belief system.
These are just a few of highly effective techniques of persuasion. Other methods include the use of rewards, punishments, positive or negative expertise, moral appeal, and many others.
1. Create a Need
One method of persuasion involves creating a need or an appealing a previously exiting need. This type of persuasion appeals to a person’s fundamental needs for shelter, love, self-esteem, and self-actualization.
2. Appeal to Social Needs
Another very effective persuasive method appeals to the need to be popular, prestigious, or similar to others. Television commercials provide many example of this type of persuasion, where viewers are encouraged to purchase items so they can be like everyone else or be like a well-known or well-respected person. Television advertisements are a huge source of exposure to persuasion considering that some estimates claim that the average American watches between 1,500 to 2,000 hours of television every year.
3. Use Loaded Words and Images
Persuasion also often makes use of loaded words and images. Advertisers are well aware of the power of positive words, which is why so many advertisers utilize phrases such as "New and Improved" or "All Natural.
The examples above are just a few of the many persuasion techniques described by social psychologists. Look for examples of persuasion in your daily experience. An interesting experiment is to view a half-hour of a random television program and note every instance of persuasive advertising. The amount of persuasive techniques used in such a brief period of time can be astonishing. [30, p.10-12]

1.3.2 Methods of persuasion
Persuasion methods are also sometimes referred to as persuasion tactics or persuasion strategies.According to Robert Cialdini in his book on persuasion, he defined six "weapons of influence":
Reciprocity - People tend to return a favor. Thus, the pervasiveness of free samples in marketing and advertising. In his conferences, he often uses the example of Ethiopia providing thousands of dollars in humanitarian aid to Mexico just after the 1985 earthquake, despite Ethiopia suffering from a crippling famine and civil war at the time. Ethiopia had been reciprocating for the diplomatic support Mexico provided when Italy invaded Ethiopia in 1937.
Commitment and Consistency - Once people commit to what they think is right, orally or in writing, they are more likely to honor that commitment, even if the original incentive or motivation is subsequently removed. For example, in car sales, suddenly raising the price at the last moment works because the buyer has already decided to buy. See cognitive dissonance.
Social Proof - People will do things that they see other people are doing. For example, in one experiment, one or more confederates would look up into the sky; bystanders would then look up into the sky to see what they were seeing. At one point this experiment aborted, as so many people were looking up that they stopped traffic. See confirmity, and the Asch conformity experiments.
Authority - People will tend to obey authority figures, even if they are asked to perform objectionable acts. Cialdini cites incidents, such as the Milgram experiments in the early 1960s.
Liking - People are easily persuaded by other people whom they like. Cialdini cites the marketing of Tupperware in what might now be called viral marketing. People were more likely to buy if they liked the person selling it to them. Some of the many biases favoring more attractive people are discussed, but generally more aesthetically pleasing people tend to use this influence excellently over others.
Scarcity - Perceived scarcity will generate demand. For example, saying offers are available for a "limited time only" encourages sales. Propaganda is also closely related to Persuasion. It's a concerted set of messages aimed at influencing the opinions or behavior of large numbers of people. Instead of impartially providing information, propaganda in its most basic sense presents information in order to influence its audience. The most effective propaganda is often completely truthful, but some propaganda presents facts selectively to encourage a particular synthesis, or gives loaded messages in order to produce an emotional rather than rational response to the information presented. The desired result is a change of the cognitive narrative of the subject in the target audience. The term 'propaganda' first appeared in 1622 when Pope Gregory XV established the Sacred Congregation for Propagating the Faith. Propaganda was then as now about convincing large numbers of people about the veracity of a given set of ideas. Propaganda is as old as people, politics and religion. [27]
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2. The characteristic features of the advertising

Advertising is a form of communication used to help sell products and services. Typically it communicates a message including the name of the product or service and how that product or service could potentially benefit the consumer. However, advertising does typically attempt to persuade potential customers to purchase or to consume more of a particular brand of product or service. Modern advertising developed with the rise of mass production in the late 19th and early 20th centuries. [15, p.100]
Many advertisements are designed to generate increased consumption of those products and services through the creation and reinvention of the "brand image". For these purposes, advertisements sometimes embed their persuasive message with factual information. There are many media used to deliver these messages, including traditional media such as television, radio, cinema, magazines, newspapers, video games, the carrier bags, billboards, mail or post and Internet marketing. Today, new media such as digital signage is growing as a major new mass media. Advertising is often placed by an advertising agency on behalf of a company or other organization.
Organizations that frequently spend large sums of money on advertising that sells what is not, strictly speaking, a product or service include political parties, interest groups, religious organizations, and military recruiters. Non-profit organizations are not typical advertising clients, and may rely on free modes of persuasion, such as public service announcements.
Money spent on advertising has increased dramatically in recent years. In 2008, spending on advertising has been estimated at over $150 billion in the United States and $385 billion worldwide, and the latter to exceed $450 billion by 2010.
While advertising can be seen as necessary for economic growth, it is not without social costs. Unsolicited Commercial Email and other forms of spam have become so prevalent as to have become a major nuisance to users of these services, as well as being a financial burden on internet service providers. Advertising is increasingly invading public spaces, such as schools, which some critics argue is a form of child exploitation. In addition, advertising frequently uses psychological pressure (for example, appealing to feelings of inadequacy) on the intended consumer, which may be harmful. [21, p. 355-356]

2.1 The influence of advertising
After watching a part of the movie thank you for smoking, it seemed like all that the producer cares about is that his product is sold no matter how unhealthy the product is. I think that advertising influences a lot of people. In fact, advertising does more than influence people’s taste, it controls our desires. People that watch a commercial, for example, want to look like that person in the advertisement; here is where advertising starts to influence people in a negative way. We usually see very thin models, for example, in most of the ads and commercials. This basically says that skinny is beautiful, or at least that is the message that it is sending to young girls, which is why we see so many girls with eating disorders today. It was all over the tabloids when Tyra Banks and Britney Spears didn’t look as thin as they were before. Basically those tabloids were saying that they are now ugly because they are not thin which makes young girls want to be thin. People, especially the young ones, are under a lot of pressure. They want to look "cool" and beautiful and I think that what they see in advertisement is what they sometimes want to become which is why they go out and buy that product. There is a proactive commercial where Jessica Simpson’s skin looks absolutely flawless. Girls that see that commercial want her skin so they go and buy proactive. I actually asked my cousin, she is a dermatologist and she said that it doesn’t work all the time, some people really like it some people hate it. Sometimes advertisers make false statements and hope that the people would not know better or wouldn’t want to find out and just go and buy the product. For example, the food pictures that we saw in class. In the ad they look very good but in reality they are not half as good. However, advertising could also have a positive influence on people. A commercial that talks about how bad smoking is for you, could influence people to stop smoking. Sometimes, even if people know what is good and bad for them, they don’t realize it until someone tells them what is good and what is bad. Whether you like it or not, at some point advertisements will influence you in a good or bad way, it is up to you to decide. [28, p.40-42]

2.2 Forms of advertising
Advertising can take a number of forms, including advocacy, comparative, cooperative, direct-mail, informational, institutional, outdoor, persuasive, product, reminder, point-of-purchase, and specialty advertising.
Advocacy Advertising Advocacy advertising is normally thought of as any advertisement, message, or public communication regarding economic, political, or social issues. The advertising campaign is designed to persuade public opinion regarding a specific issue important in the public arena. The ultimate goal of advocacy advertising usually relates to the passage of pending state or federal legislation. Almost all nonprofit groups use some form of advocacy advertising to influence the public's attitude toward a particular issue.
Comparative Advertising Comparative advertising compares one brand directly or indirectly with one or more competing brands. This advertising technique is very common and is used by nearly every major industry, including airlines and automobile manufacturers. One drawback of comparative advertising is that customers have become more skeptical about claims made by a company about its competitors because accurate information has not always been provided, thus making the effectiveness of comparison advertising questionable.
Cooperative Advertising Cooperative advertising is a system that allows two parties to share advertising costs. Manufacturers and distributors, because of their shared interest in selling the product, usually use this cooperative advertising technique. An example might be when a soft-drink manufacturer and a local grocery store split the cost of advertising the manufacturer's soft drinks; both the manufacturer and the store benefit from increased store traffic and its associated sales. Cooperative advertising is especially appealing to small storeowners who, on their own, could not afford to advertise the product adequately.
Direct-Mail Advertising Catalogues, flyers, letters, and postcards are just a few of the direct-mail advertising options. Direct-mail advertising has several advantages, including detail of information, personalization, selectivity, and speed.
Informational Advertising In informational advertising, which is used when a new product is first being introduced, the emphasis is on promoting the product name, benefits, and possible uses
Institutional Advertising Institutional advertising takes a much broader approach, concentrating on the benefits, concept, idea, or philosophy of a particular industry. Companies often use it to promote image-building activities, such an environmentally friendly business practices or new community-based programs that it sponsors. Institutional advertising is closely related to public relations, since both are interested in promoting a positive image of the company to the public.
Outdoor Advertising Billboards and messages painted on the side of buildings are common forms of outdoor advertising, which is often used when quick, simple ideas are being promoted. Since repetition is the key to successful promotion, outdoor advertising is most effective when located along heavily traveled city streets and when the product being promoted can be purchased locally. Only about 1 percent of advertising is conducted in this manner.
Persuasive Advertising Persuasive advertising is used after a product has been introduced to customers. The primary goal is for a company to build selective demand for its product. For example, automobile manufacturers often produce special advertisements promoting the safety features of their vehicles.
Product Advertising Product advertising pertains to nonpersonal selling of a specific product.
Reminder Advertising Reminder advertising is used for products that have entered the mature stage of the product life cycle. The advertisements are simply designed to remind customers about the product and to maintain awareness.
Point-of-Purchase Advertising Point-of-purchase advertising uses displays or other promotional items near the product that is being sold. The primary motivation is to attract customers to the display so that they will purchase the product.
Specialty Advertising Specialty advertising is a form of sales promotion designed to increase public recognition of a company's name. A company can have its name put on a variety of items, such as caps, glassware, gym bags, jackets, key chains, and pens. The value of specialty advertising varies depending on how long the items used in the effort last. Most companies are successful in achieving their goals for increasing public recognition and sales through these efforts. [18]

2.3 Objectives of the advertising
Advertising objectives are the communication tasks to be accomplished with specific customers that a company is trying to reach during a particular time frame. A company that advertises usually strives to achieve one of four advertising objectives: trial, continuity, brand switching, and switchback. Which of the four advertising objectives is selected usually depends on where the product is in its life cycle.
Trial The purpose of the trial objective is to encourage customers to make an initial purchase of a new product. Companies will typically employ creative advertising strategies in order to cut through other competing advertisements. The reason is simple: Without that first trial of a product by customers, there will not be any re peat purchases.
Continuity Continuity advertising is a strategy to keep current customers using a particular product. Existing customers are targeted and are usually provided new and different information about a product that is designed to build consumer loyalty.
Brand Switching Companies adopt brand switching as an objective when they want customers to switch from competitors' brands to their brands. A common strategy is for a company to compare product price or quality in order to convince customers to switch to its product brand.
Switchback Companies subscribe to this advertising objective when they want to get back former users of their product brand. A company might highlight new product features, price reductions, or other important product information in order to get former customers of its product to switchback. [18]

2.4 Selecting the Right Advertising Approach
Once a company decides what type of specific advertising campaign it wants to use, it must decide what approach should carry the message. A company is interested in a number of areas regarding advertising, such as frequency, media impact, media timing, and reach.
Frequency. Frequency refers to the average number of times that an average consumer is exposed to the advertising campaign. A company usually establishes frequency goals, which can vary for each advertising campaign. For example, a company might want to have the average consumer exposed to the message at least six times during the advertising campaign. This number might seem high, but in a crowded and competitive market repetition is one of the best methods to increase the product's visibility and to increase company sales. The more exposure a company desires for its product, the more expensive the advertising campaign. Thus, often only large companies can afford to have high-frequency advertisements during a campaign.
Media Impact. Media impact generally refers to how effective advertising will be through the various media outlets (e.g., television, Internet, print). A company must decide, based on its product, the best method to maximize consumer interest and awareness. For example, a company promoting a new laundry detergent might fare better with television commercials rather than simple print ads because more consumers are likely to see the television commercial. Similarly, a company such as Mercedes-Benz, which markets expensive products, might advertise in specialty car magazines to reach a high percentage of its potential customers. Before any money is spent on any advertising media, a thorough analysis is done of each one's strengths and weaknesses in comparison to the cost. Once the analysis is done, the company will make the best decision possible and embark on its advertising campaign.
Media Timing. Another major consideration for any company engaging in an advertising campaign is when to run the advertisements. For example, some companies run ads during the holidays to promote season-specific products. The other major consideration for a company is whether it wants to employ a continuous or pulsing pattern of advertisements. Continuous refers to advertisements that are run on a scheduled basis for a given time period. The advantage of this tactic is that an advertising campaign can run longer and might provide more exposure over time. For example, a company could run an advertising campaign for a particular product that lasts years with the hope of keeping the product in the minds of customers. Pulsing indicates that advertisements will be scheduled in a disproportionate manner within a given time frame. Thus, a company could run thirty-two television commercials over a three-or six-month period to promote the specific product is wants to sell. The advantage with the pulsing strategy is twofold. The company could spend less money on advertising over a shorter time period but still gain the same recognition because the advertising campaign is more intense.
Reach. Reach refers to the percentage of customers in the target market who are exposed to the advertising campaign for a given time period. A company might have a goal of reaching at least 80 percent of its target audience during a given time frame. The goal is to be as close to 100 percent as possible, because the more the target audience is exposed to the message, the higher the chance of future sales. [6, p.38-40]

3. Web advertising

It has been suggested that online advertising is currently based on a print media model that is likely to develop into an interactive television model in years to come. Like print media, Web pages are largely text-based and must generally be read. Television, on the other hand, reflects a lower, more passive level of involvement. However, the interactive capabilities of the Internet certainly distinguish it from other media.
Drèze and Zufryden once suggested that the Internet offers unique but largely unexplored opportunities for advertising research that exist in spite of its popularity as a medium for marketing and promoting products and services. Three years is a long time on the Web, with great strides made in online advertising research during that time. Nevertheless, there is still widespread debate over the effectiveness of various Web advertising formats. Amid frequent claims that "the banner is dead", it is interesting to note that banner advertising revenue and the number of sites using banner ads have continued to increase. [12, p.80]
The emphasis of this study is on the application of copy testing methods to banner advertisements appearing on the World Wide Web. It is specifically concerned with the effect on consumer behavior generated by banner ads containing pull-down menus. These are menus accessed by clicking the computer's mouse pointer on an arrow appearing in the advertisement, thereby opening a menu containing further information or links to a specific Web page. Although banner ads are themselves interactive in nature and therefore somewhat unique, the use of pull-down menus adds a further layer of interactivity. Viewers may click on these to obtain more information before being transferred to the advertiser's Web site.
In this paper, a paired comparison approach is used to examine whether banner ads containing pull-down menus are more effective than conventional banner ads in terms of several widely employed advertising copy testing measures. Testable hypotheses are proposed that will provide an insight into the nature of banner advertising that will benefit both online advertisers and advertising researchers alike. [12, p.82]

3.1 Banner Advertising.
The most popular form of advertising on the Internet's World Wide Web is currently banner advertising. A banner (graphic image) and link are displayed on a high traffic web site, in which the people visiting that site (the audience) see when the page loads. This banner commonly advertises a product, service, or just another web site. It can also be used to show someone's point of view on a certain topic (for example, a presidential election).
A web banner or banner ad is a form of advertising on the World Wide Web. This form of online advertising entails embedding an advertisement into a web page. It is intended to attract traffic to a website by linking to the website of the advertiser. The advertisement is constructed from an image (GIF, JPEG, PNG), JavaScript program or multimedia object employing technologies such as Java, Shockwave or Flash, often employing animation, sound, or video to maximize presence. Images are usually in a high-aspect ratio shape (i.e. either wide and short, or tall and narrow) hence the reference to banners. These images are usually placed on web pages that have interesting content, such as a newspaper article or an opinion piece.
Typical web banner, sized 468×60 pixels.
The web banner is displayed when a web page that references the banner is loaded into a web browser. This event is known as an "impression". When the viewer clicks on the banner, the viewer is directed to the website advertised in the banner. This event is known as a "click through". In many cases, banners are delivered by a central ad server.
When the advertiser scans their logfiles and detects that a web user has visited the advertiser's site from the content site by clicking on the banner ad, the advertiser sends the content provider some small amount of money (usually around five to ten US cents). This payback system is often how the content provider is able to pay for the Internet access to supply the content in the first place.
Web banners function the same way as traditional advertisements are intended to function: notifying consumers of the product or service and presenting reasons why the consumer should choose the product in question, although web banners differ in that the results for advertisement campaigns may be monitored real-time and may be targeted to the viewer's interests.
Many web surfers regard these advertisements as highly annoying because they distract from a web page's actual content or waste bandwidth. (Of course, the purpose of the banner ad is to attract attention and many advertisers try to get attention to the advert by making them annoying. Without attracting attention it would provide no revenue for the advertiser or for the content provider.) Newer web browsers often include options to disable pop-ups or block images from selected websites. Another way of avoiding banners is to use a proxy server that blocks them, such as Privoxy. [10, p.40-42]

3.1.1 History of banners.
The first clickable web ad (which later came to be known by the term "banner ad") was sold by Global Network Navigator (GNN) in 1993 to Heller, Ehrman, White and McAuliffe, a now defunct law firm with a Silicon Valley office. GNN was the first commercially supported web publication and one of the very first web sites ever.
HotWired was the first web site to sell banner ads in large quantities to a wide range of major corporate advertisers. Andrew Anker was HotWired's first CEO. Rick Boyce, a former media buyer with San Francisco advertising agency Hal Riney & Partners, spearheaded the sales effort for the company. HotWired coined the term "banner ad" and was the first company to provide click through rate reports to its customers. The first web banner sold by HotWired was paid for by AT&T, and was put online on October 25, 1994. Another source also credits Hotwired and October 1994, but has Coors' "Zima" campaign as the first web banner.
In May 1994, Ken McCarthy, an early Internet commercialization pioneer, who mentored Boyce in his transition from traditional to online advertising, first introduced the concept of a clickable/trackable ad. He stated that he believed that only a direct response model—in which the return on investment of individual ads was measured—would prove sustainable over the long run for online advertising.
In spite of this prediction, banner ads were valued and sold based on the number of impressions they generated. This approach to banner ad sales proved successful and provided the economic foundation for the web industry from the period of 1994 to 2000 until the market for banner ads "crashed" and there was a radical revaluation of their value.
The new online advertising model that emerged in the early years of the 21st century, introduced by GoTo.com (later Overture, then Yahoo and mass marketed by Google's AdWords program), closely resembled the pioneer's 1994 projection. [17, p.12-14]

3.1.2 Types of banner advertisings
Though, as seen above, the large majority of online advertising has a cost that is brought about by usage or interaction of an ad, there are a few other methods of advertising online that only require a one time payment. The Million Dollar Homepage is a very successful example of this. Visitors were able to pay $1 per pixel of advertising space and their advert would remain on the homepage for as long as the website exists with no extra costs.
· Floating ad: An ad which moves across the user's screen or floats above the content.
· Expanding ad: An ad which changes size and which may alter the contents of the webpage.
· Polite ad: A method by which a large ad will be downloaded in smaller pieces to minimize the disruption of the content being viewed
· Wallpaper ad: An ad which changes the background of the page being viewed.
· Trick banner: A banner ad that looks like a dialog box with buttons. It simulates an error message or an alert.
· Pop-up: A new window which opens in front of the current one, displaying an advertisement, or entire webpage.
· Pop-under: Similar to a Pop-Up except that the window is loaded or sent behind the current window so that the user does not see it until they close one or more active windows.
· Video ad: similar to a banner ad, except that instead of a static or animated image, actual moving video clips are displayed. This is the kind of advertising most prominent in television, and many advertisers will use the same clips for both television and online advertising.
· Map ad: text or graphics linked from, and appearing in or over, a location on an electronic map such as on Google Maps.
· Mobile ad: an SMS text or multi-media message sent to a cell phone.
In addition, ads containing streaming video or streaming audio are becoming very popular with advertisers.
- Common Banner Ads - Currently the most common type of banner advertising is by showing the banner near the top of the web page. If this is a paid banner it is usually the only banner ad that appears on the page. This type of banner space is usually sold by impressions, or banner views, although it is sometimes sold by click-thru, when the user clicks on the banner for more information.
- Medallion Ads - This type of advertising is newer and not widespread. A column of multiple smaller banners are shown on the side of the web page. Because so many ads appear on a single page, it is usually sold by click-thru only. This type of advertising gives the page designer less room for content, so is usually only used on pages with written articles, such as webzines.
There are two major types of banners, static banners and dynamically-rotated banners. Static Banners do not change, they stay the same to every user, every page load. Dynamically-Rotated Banners can change for each user.
A dynamically-rotated banner is usually a more effective way of advertising, but it requires a program to work, most commonly a .cgi script. With dynamic-rotation, you are able to advertise a different banner to each viewer, therefore you are able to have multiple advertisers, or, mulitiple banners for one advertiser, or any combination. With a static banner, you can only have a single banner, and only a single advertiser for that page. [24, p.36-38]

[bookmark: uses]3.1.3 Uses for Web Banner Advertising
This probably the mostly likely thing that you will use banner advertising for.
· To sell more of your product(s) or service(s).
· To be able to notify buyers of your new product or service, or offer them a special deal/discount.
· To Spread your ideas about a certain topic.
· To get people to remember your company's name! (Incase they wish to have your products or services in the future!)Advertising on the Web with banners means more sales and/or more influence!
[bookmark: advan]Advantages of advertising independently.
Freedom: If you get to choose your own rates, standards, etc you will have better control over the layout of your site. If you are independent you make your own rules.
More Reliable: You ads don't go down unless your site goes down. You won't have to wind up finding a new advertising broker if you current one declares bankruptcy.
[bookmark: disadvan]More Profitable/Less Expensive: By running your own ads, you will be able to ask more from the person wanting to advertise, yet your asking price will be able to be lower than what your broker/rotator would charge. So you earn more, and the people who wish to advertise will pay less. Everyone is happier.
Disadvantages of independent Advertising.
More Work for you: Getting your own advertisers and maybe customizing the rotator and/or rewriting one can be a real challenge. If you want to be independent, expect to spend much more time working, and maybe even being a little more stressful. (If you saw how much larger your paychecks would be you wouldn't mind that much...)
More Costly to Run: Having a server that is able to handle your rotation scripts may be more expensive then what you currently pay. It is most unlikely to find an free provider that will allow you to run these simple (yet complex) scripts. [28, p.39-41]

[bookmark: Introduction][bookmark: Literature][bookmark: Copy]3.2 Copy Testing Banner Advertisements
Copy testing is widely used in the advertising industry to assess the effectiveness of a particular advertisement or campaign. Traditional copy testing research methods generally involve exposing consumers to an advertisement and then soliciting responses afterward. Early copy testing methods predominantly used recall as the most important measure of advertising effectiveness. However, multiple measures have been used in more recent years, including recall, recognition, personality, brand image, purchase intent, persuasion, liking, main point communication/playback, and awareness. These measures are based upon models of consumer behavior (such as the AIDA - attention, interest, desire, action - framework) that suggest consumers may pass through cognitive, affective, and behavioral stages in response to a stimulus.
To determine banner ad effectiveness, four copy-testing measures will be employed in this research: 1) attention, 2) novelty, 3) liking, and 4) persuasion. It has been argued that the constructs of attention and novelty are important factors in creating effective advertisements. Researchers have also claimed that measures of likability and persuasion represent a successful combination of copy testing measures that can be used for predicting the likely success of an advertisement.

3.2.1 Novelty
One of the more common means of attracting and holding a consumer's attention is by creating a novel structural execution for the advertisement. In other words, the creative copy should use distinctive, unusual, or unpredictable devices. In this way, it is possible to draw consumers' attention not only to the advertisement, but also to key visual and verbal information. The relative absence of banner ads on the Web that use pull-down menus implies a degree of novelty in itself. Consumers may attend to and click on these ads because of their unusual structure, newness, or novelty value. It is therefore hypothesized that. Banner advertisements that contain pull-down menus will result in significantly higher novelty responses than banner ads containing no pull-down menus.

3.2.2 Effect on Click-Through
[bookmark: Method]Given the expectation that banner ads containing pull-down menus will result in higher attention, novelty, liking, and persuasion scores, it is reasonable to expect that they would be more likely to initiate consumer action in the form of clicking on the banner than static banner ads. Hence. Banner advertisements that contain pull-down menus will result in significantly higher click-through rates than banner ads containing no pull-down menus.

3.2.3 Sampling and Data Collection
The sample for this research was comprised of undergraduate and postgraduate students of an east coast Australian university who had completed or were currently enrolled in an Internet Marketing course at the university in 1999. The logic underlying the choice of sample was that this group would be most likely to respond to an e-mailed invitation to participate in the research. Because the stimulus was a banner ad, it was also essential to use participants who had Internet access for the study. Participants were informed in the class that they would be receiving an e-mailed request to participate in the research within the next week. Additionally, it was reasonable to assume that they would be more comfortable with World Wide Web technology and research than non-Web users.
Three hundred and fifty-six e-mail messages were sent to prospective respondents, requesting them to visit a specified Web address and read the information provided there. Following the reading of this information, respondents were asked to complete an online questionnaire. One hundred and ninety-six people responded to the e-mail requests giving a response rate of 55.1%.

[bookmark: Results][bookmark: Discussion]3.2.4 Discussion
This study was developed as a means of copy testing banner advertisements in terms of their attention, novelty, likability, and persuasion effects. Evidence has already suggested that banner ads contribute to brand awareness and brand strength. This may be due, in part, to the sheer publicity effect of advertising. However, copy testing different banner ad formats may offer a unique opportunity to determine their advertising effectiveness or lack thereof. The limited presence of banner ads using pull-down menus on the Web may be construed in one of two ways: 1) they are simply less effective than conventional banner ads and this is reflected in their minority use, or 2) they are slow to be recognized as advertisements that are more effective. Overall, the results of this study provide considerable support for the latter, with the outcome suggesting that banner ads with pull-down menus result in significantly higher scores on the copy testing variables utilized.
As expected, banner ads with pull-down menus are viewed as more novel and tend to attract more attention than static banners. This is not surprising given the comparatively unique structural format of ads containing pull-downs menus. Results from Hypothesis 3 suggest that banner ads containing pull-down menus are more liked than those without them are. One explanation for this may be that the increased informational content of the advertisement is preferred by consumers. This is consistent with other research by Greene and Biel and Bridgewater which produced similar conclusions, albeit in different media. Further research is needed to replicate the findings; however, the likability of pull-down banner ads is strongly supported by the data.
Click-through rate is an important factor in online advertising with many firms' billing now based on clicks generated rather than the conventional cost-per-thousand exposures (CPM) model. The data suggest that banner ads that use pull-down menus are more likely to be clicked on than static banner ads; hence, advertisers would be advised to use this format more frequently. It is evident that the click-through rates of both groups of respondents are very high when compared with commercial advertising click-through rates. These fluctuate depending upon Web site and page placement with the norm around 2%. They are rarely higher than 10% and the inflated result of this study may be a consequence of respondents' awareness that this was a research project. They may thus have directed more attention to the advertisement than would otherwise have been the case. However, the difference in click-through between the two groups was still statistically significant, and suggests that the pull-down format is more effective than using conventional, static banner ads.
[bookmark: Practical]
3.2.5 Practical Implication
The results obtained from this study lend weight to the argument that banner ads with pull-down menus provide a better alternative to conventional, static banner advertising. They offer consumers the means of gaining more product information without having to leave a Web site and are clicked on more than conventional banners, thereby focusing greater attention on these ads. Although they are still relatively simplistic, like much current Web advertising, these types of banner ad may mark the first steps in a new online advertising paradigm that is based on providing detailed, personalized information to the consumer.
As a communication tool, advertisers, agencies, and researchers should consider the benefits of using pull-down menus in more banner ads. Future developments should bear in mind the informational aspect of banner ads and their potential for providing important and more detailed information before taking consumers away from their current Web site. In addition, it is clear that the novelty impact of these types of banner advertisements can strongly influence click-through rate and this benefit is probably being under-exploited in the online advertising industry. The banner ad may be much maligned as a form of creative advertising, but it is likely to be with us for some time yet as bandwidth limitations are still impeding the delivery of high quality moving images and sound similar to television. Advertisers should capitalize on the most effective means of utilizing this communication vehicle, which may well involve the use of pull-down menus as a prominent promotional tool. [10, p.40-48]

4. The use of metaphor in on-line advertising

This study of metaphor in on-line advertising examined commercial web sites that promote goods or services on the Internet’s World Wide Web. Fourteen such web sites were observed and content analyzed according to the coding manual developed through literature reviews and web site observations. These web sites were sampled for their high consumer traffic and popularity.
The purpose of this chapter is to provide advertisers and marketers useful information when developing an Internet presence. By exploring the current uses of metaphor in on-line advertising, advertisers can gain a greater understanding of their competitor’s efforts and thus produce more effective web presentations for their own corporation. After introducing terminology related to metaphors on the Internet’s World Wide Web, the research study investigates the way advertisers use metaphors to actively involve consumers in on-line messages. Based on the findings, implications for further study of on-line advertising are also examined. [22]

4.1 The Study of Metaphor in Advertising
Metaphor has been used in artistic and literary expression for centuries and continues to be a form of expression used in popular culture at the end of the twentieth century. Advertising, a form of corporate expression, is not exempt from metaphorical usage since it so intertwines artistic images and literary phrases. As the age of information and electronic media is upon us, advertising has penetrated these realms as well, taking with it creative ways to give meaning and message to products and services. Metaphor is just one of the ways of expressing concepts that companies are utilizing in their web sites on the Internet’s World Wide Web. The current study seeks to identify and describe the common types of metaphors used by corporations in their commercial web sites. [7, p.25]

4.1.1 What is metaphor in the on-line world
Since the current study deals with metaphors of the on-line world, a definition of metaphor from the Internet can help define the topic of study. According to The Metaphor Home Page, metaphor can be defined as "any structured juxtaposition of two conceptual domains. Metaphor thus encompasses language, cinema, theatre, music, and even dance, etc., in fact any domain that one can sensibly describe in a structured semantic form". To interpret this definition for purposes of the paper, a metaphor is an unusual pairing of two elements that creates a new meaning that neither element had alone, thus creating a whole new conceptual expression.
For example, in the verbal metaphor illustratively used by Max Black, MAN IS WOLF, the reader is asked to think of the man in terms of the barbaric and beastly nature of a wolf. Man can be seen as possessing some of the qualities of a wolf, but not all of them. The transference of properties is relative to the context and one cannot assume that man is exactly the same as a wolf, but somehow similar. The context should make apparent which qualities the sender of the metaphor wishes the audience to transfer to the primary subject, man. If framed in a business context, perhaps the man could be viewed as cunning, whereas in a dating situation, MAN IS WOLF could evoke images of a wolf scouting for prey.
Whatever the metaphor, two elements, or subjects, are unusually paired so that one subject is conceived in terms of the second. The metaphor may be presented in images, or may even require the addition of words to convey its meaning. Regardless, some properties or characteristics of the secondary subject are transferred to the first and a whole new concept formed. The slight tension of the pairing will increase the viewer/reader’s need to reconcile the juxtaposition and result in the comprehension of the metaphor. The viewer/reader will understand the pairing of the two subjects in a new and completely different light than if the two subjects were presented independently. The need to reconcile this tension may require more active involvement from the viewer/reader.
Thus, metaphor has implications for advertising, as active audiences are highly desirable and interpret the advertising message in a more meaningful and personal way. When more time is spent reading, viewing, and interpreting a message, the meaning is more internalized. Therefore, advertising seeks to involve the consumer so that he or she will internalize the message that product X is the best for cleaning carpets, etc. Web advertising also attempts to draw in the viewer/reader to spend more time with the message. The inherent fast-paced nature of Internet surfing can leave a consumer’s mind cluttered with many messages and products vying for attention. If a consumer could interact with the advertising message, such as clicking the mouse button on an advertisement’s words or images, the message has a higher likelihood of being more internally processed. The more time the consumer spends with the advertisement, the better for the advertiser.
The on-line metaphors under examination for the purposes of this study will primarily be concerned with language (written text), visual images (photos, hand or computer drawn images, video, or digital animation), and the combination of the two.
Thus an advertisement containing words, visual images, or both will be considered in exploring metaphor. With this in mind, metaphors have been classified to distinguish differences in the usage of metaphor in advertising (Forceville). In this study of metaphor usage in on-line advertising, three types of metaphor, drawn from Forceville’s work, have been defined as follows. Verbal metaphors are textual written language used to convey meaning of the first subject. Pictorial metaphors use images for the first element, without words or any text accompanying the visual image. A combination of images and words as the primary subject will result in a verbo-pictorial metaphor being observed. Some verbopictorial metaphors may require both the image and the text to support each other for clear understanding while others may not need the assistance of the other to be understood, but both may still be presented for greater clarity. Regardless, if the first subject contains both words and images, it shall be considered a verbo-pictorial metaphor.
For example, you can find a pictorial metaphor that uses only visual images to convey the meaning of the primary subject. The musical notes with the sound waves radiating from the stems implies someone is hearing or listening to music. There is found beside certain musical compact discs for sale at the Music Boulevard web site. This pictorial metaphor indicates that, when clicked with the mouse, music will play. This image is only located beside those CD’s that have audio available for listening on-line.
An example of a verbal metaphor can be found at http://www.marthastewart.com. The words, "Guest Book Sign-In," are completely textual and have no accompanying images of any kind. This phrase, as the primary subject, leads the web surfer to actually sign-in and make comments as one would do in the real world. This virtual guest book is a prime example of a verbal metaphor on-line.
Lastly, verbo-pictorial metaphors combine both text and images in the primarysubject that work collectively to aid the viewer. The Virtual Vineyards web site, locatedat http://www.virtualvin.com, displays an example of this type of metaphor. The Wine Shop is just one of the many departments in the on-line store of Virtual Vineyards, presented by a bottle and glass of wine paired with the words, "Shop for Wine." The web surfer uses the mouse to click upon this primary subject and is swept away to the wine shop. The combination of the verbal and visual elements clarifies the meaning of this virtual shopping experience. [8, p.20-27]

4.1.2 Objectives of the use of metaphors in advertising
There are four primary objectives of this research.
First, the study seeks to develop a coding method for metaphor to be used in a content analysis of corporate web sites. Classifications of metaphor will be set forth in a hierarchical fashion that will help the researcher to clearly identify a metaphor and to distinguish one type of metaphor from another. These classifications will be developed from both literature and observation.
Secondly, the study will collect data from the observation of commercial web sites, as defined earlier. Metaphors from these web sites will be thoroughly explored and examined.
Third, the observed metaphors will be coded and counted according to the codebook developed through achievement of the first objective of the study. The sample will provide information on the frequency of certain types of metaphors and help to identify the most commonly used types of metaphor. Metaphors used in shopping and non-shopping sites will be compared and contrasted to examine differences and influences on group membership. Coding and analyzing the collected data will be done through the computer program SPSS, Statistical Program for Social Sciences.
Lastly, with the knowledge from the research results, any significant findings will be presented and differences among the two groups, shopping and non-shopping web sites, will be discussed. The conclusions will make suggestions for the application of metaphor in online advertising and its further uses. The results should answer the following questions:
1). What is the most common type of metaphor used in on-line advertising in 1998?
2). Is there a difference between metaphor usage in shopping versus non-shopping web sites?
3). What are the influencing factors that account for these differences? [23]

4.2 Metaphor in on-line advertising
In observing metaphors in on-line advertising, key terminology must be defined to clearly identify metaphors within a limited framework. The current study’s framework is metaphors in on-line advertising. Advertising on the World Wide Web can take several forms, from commercial web sites designed specifically for promotional purposes to banner ads, small banner-shaped areas used for ad space as in traditional media. However, this study is focusing on commercial web sites that advertise, promote, and market goods and services. The Internet’s World Wide Web was used to view these commercial web sites, which are web presentations that contain several pages usually arranged in a hierarchy. The starting page is commonly referred to as the home page, containing many hyperlinks. These links, when text, are usually blue in color and underlined as well. When a mouse is used to click on these hyperlinks, the web surfer loads another web page, either contained within the same web presentation or another page from a separate web presentation.
Commercial web sites will be defined as web presentations that market, promote, and/or sell goods or services for a sponsoring corporation. The web address of the home page will usually end in ".com," meaning commercial. Most web addresses, or also contain the corporation’s name, as in http://www.gap.com/, an example of the web address for the clothing company, The Gap. Two types of commercial web sites will be examined, shopping and non-shopping sites. The web sites that actually sell products or services via the Internet will be classified as shopping sites. Other web sites that simply promote goods and services not for sale on-line but for sale only in tradition retail outlets will be classified as non-shopping sites. [31, p.38-40]

4.2.1 Visual metaphors in advertising
Visual metaphor scholars, often unhappy with the literary perspective, have begun to develop theories of their own. As discussed earlier, Indurkhya’s studies attempt to "develop unifying accounts of metaphor that can apply to verbal and nonverbal contexts". Indurkhya’s semantic transference uses new terminology that could apply to both verbal and nonverbal metaphors, both in description and explanation of the function of metaphors. Van Noppen summarizes Indurkhya’s theory: "Metaphor is the description of a target domain in terms of a source domain; a transfer from one domain to another, characterized by different functions which condition the interpretation of metaphoric utterances". He is considered one of the few authors developing a new context that is not strictly literary, but one that is cross-categorizeable to verbal and nonverbal metaphor analysis. Also, some of Black’s basic tenants are still at work, especially those of transference or mapping features of one ‘subject’ onto the other. The interaction of the two elements or ‘domains’ is still the key to understanding how metaphor works.
Even literary theorists recognize that metaphors do not require language to transfer meaning from one subject to another. Kittay writes, " In exploring metaphor as a phenomenon of language, I do not mean to claim that metaphor is found only in language nor that metaphor is merely linguistic. We can have metaphor in dance, in painting, in music, in film, or in any other expressive medium".
Rudolf Arnheim, in his studies of visual perception, finds metaphor in the expressive medium of visual art. In his discussion of symbolism in art, he recognizes that metaphor unites "practically disparate objects" and "derives from and relies on the universal and spontaneous way of approaching the world of experience".
The metaphorical communication has become a part of how meaning is conveyed in our messages to one another. Metaphor, even in art, has passed down meaning from generation to generation and thus developed a socially accepted norm of metaphorical expression.
Leiss, Kline, and Jhally have used metaphor to study social communication in advertising. They suggest that metaphors in advertisements have become a powerful and commonly used strategy. "Metaphor is the very heart of the basic communication form used in advertising". Many other researchers share this view as they seek to explain the effects of metaphor use in advertising.
The study of metaphor in advertising has been used to gain insight about consumer behavior. Zaltman’s Metaphor Elicitation Technique (ZMET) was a research tool developed to define and describe the metaphors that drive consumer behavior with implications for copy testing. Metaphors are relevant to the study of advertising because metaphors are "laden with symbols and imagery that might be used creatively in implementing decisions that will animate or bring appropriate reasoning processes and mental models to life.
Stern also is an advocate of studying symbolism along with metaphor in advertising. Stern believes that advertising is a metaphorical art, much like poetry. She is more interested in verbo-pictorial metaphors (in Forceville’s terms) than strictly verbal metaphors since "words alone cannot convey the burden of meaning". Print, television, and even the Internet’s World Wide Web may be more appropriate media as they are not limited to verbal communication. Stern’s work, although concerned with visual metaphors, still concerns the integration of verbal elements.
Charles Forceville tries to look at previous metaphor literature in hopes of developing a theory of pictorial metaphor in advertising, but notes that most of the literature on metaphor is primarily on verbal metaphors (Forceville, 4). Forceville uses the cognitive perspective from Black’s interaction theory and extends that to what he calls a pictorial theory of metaphor in advertising. "Metaphor occurs first of all on the level of cognition, and can manifest itself on the pictorial as well as the verbal level – and possibly in yet other ways". Forceville has done content analyses of advertisements to locate four distinct types of pictorial metaphors in advertising: (1) Pictorial metaphors with one pictorially present term, (2) Pictorial metaphors with two pictorially present terms, (3) Pictorial similes, and (4) Verbo-pictorial metaphors.
Homer and Kahle propose a social adaptation explanation of visual metaphors, where "problems are solved by rearranging what we have always known….combined in such a way as to evoke something else". Socially accepted norms are rearranged by juxtaposing two elements that interact and create tension. Homer & Kahle specifically studied surrealistic images, but their definition of surrealistic content is related to metaphor and can be discussed along with metaphor studies. Similar to metaphor, they describe the effects of surrealism: "By juxtaposing unrelated objects, they revealed unexpected affinities between different objects". They investigated the effects of metaphor use on persuasion, finding that ads incorporating surrealistic content produced greater recall and purchase intent than other more traditional advertisements.
Similarly, Fazio, Zanna, and Cooper have found that direct experience may affect attitude formation by altering the way in which the available information is processed (Fazio et al, 51). Since metaphors in consumer advertising require the consumer to become more actively involved and experience one thing in terms of another, advertising using metaphors may affect attitude formation towards a product or brand. At the very least, the active involvement stimulated by metaphors will alter the way in which the information is processed. [14]

4.2.2 Virtual metaphors of the Web
Metaphors are one way to promote interactivity. Computer design of a graphical user interface was first to utilize metaphors to encourage interactivity of the computer user. With a Macintosh windows operating system and a mouse, early computer users pointed and clicked to interacted with their virtual world. Tim Rohrer speaks of ‘virtual’ metaphors in computer interface design, such as the virtual desktop of the Apple Macintosh OS. "In the DESKTOP metaphor, the computer screen is a virtual ‘desktop’ with electronic ‘folders,’ ‘documents,’ ‘disk icons’ and a ‘trash can’ which are patterned after the physical objects in the physical office".
In the late twentieth century, metaphors in the on-line world are combining ideas from literary and pictorial metaphors, as well as those from early computer interface design, into virtual metaphors. Many graphic icons use symbolism, pictographs, and other elements from semiotics along with linguistic metaphor in hopes of catching the eye of a Web surfer. On-line metaphors are often images, while others are text, and still others combine both text and images. These computerized metaphors present the viewer with a semblance of the actual physical world on their computer screen. For example, Security First Network Bank, the first financial services institution to offer full-service banking on the Internet, uses on-line metaphors. "The company uses the graphic metaphor of a conventional bank to communicate and interact with potential and existing customers, including an electronic inquiries desk, electronic brochures for general information, and electronic tellers to deal with routine transactions".
On-line metaphors should entice the computer user to interact with the icons or images in a way that is intuitive. These images should represent closely their real-world counterparts and if performing a function, they should be clear as to what function it is they perform. Rohrer agrees with this assumption, first presented by Collins, when he states that "metaphors are most intuitive to users when they are fairly literal". As a marketer, the goal is to have consumers become more interactive with your message and your products. Thus leading to purchases and eventually repeat purchases. The more intuitive this process is, the more likely the advertiser can convert the casual web surfer to a loyal customer. To accomplish this goal on-line, the web site should hold the visitor’s attention, be readable, and be visually appealing as well as inform.
On-line users, especially on-line shoppers, actively seek interaction with this virtual world to perform functions such as browsing a catalogue or ordering merchandise much like they would in the real world. Metaphors provide a quick, easy way to present information to on-line consumers that also allow interaction. On screen images and words entice web surfers to click and interact with these metaphors in ways similar to their real world interactions, such as traditional advertising and in-store displays. [14]

4.3 Methodology of the metaphor usage
The purpose of this chapter is to operationalize several key terms not yet clearly defined and to present the methodology of the research study at hand. Determination of the sample and sample size will also be explained. Methods examined will be those for coding, collection, and analysis of the data utilized throughout the research study.

4.3.1 Metaphor key terms definitions
Definitions of metaphor and the various types studied through this research are summarized below.
- Metaphor: an unusual pairing of two elements that creates tension when one element transfers meaning to another, thus creating a new concept different from what one element would have without the other;
- Pictorial metaphor: a metaphor as defined above where the first element, or subject, is an image rather than words;
- Verbal metaphor: a metaphor as defined above where the primary subject is presented in language rather than images;
- Verbo-Pictorial metaphor: a metaphor as defined above where the first element is presented in language and images; the text and images need not be dependent upon the other for understanding, but they may be supportive of one another.

4.3.2 Data Collection Methods
To compare commercial web sites on the Internet, high volume sites were needed. Therefore, a judgmental sample was utilized in order to study the highest-traffic commercial sites on the Internet’s World Wide Web. PC Magazine on-line has identified the top 100 web sites by traffic in five categories: Commerce, Computing, Entertainment, News & Views, and Reference. The commerce category was employed in this study since this collection of web sites contains corporations selling a good or service via their on-line presence, usually with their web address ending in ".com," meaning commercial. The Top 26 commercial web sites, as identified by PC Magazine on-line’s September 2008 edition, were viewed and sampled for metaphors. Web sites that operated on individual persons placing classified ads to sell products or auction products were omitted from the sample since they did not meet the requirement of being a corporation promoting or selling a good or service. Web sites were first divided into either "shopping" or "non-shopping" categories. The shopping sites were defined as corporate web sites that not only promoted goods and services on-line, but also offered viewers the opportunity to purchase their products. Non-shopping sites often promoted and marketed the corporation’s products, but there was no on-line selling of items, leaving the consumer to make their purchases in traditional retail outlets or elsewhere. With fewer non-shopping sites, it was necessary to identify the top non-shopping sites first and to select the same number of shopping sites for comparison. September’s top commerce sites contained seven nonshopping sites and therefore the top seven shopping sites were also chosen for comparison. The top fourteen of these commercial sites, with the exclusion of the classified and auction sites, were selected as the two independent samples. Sites were examined thoroughly, starting with the home page, and all potential metaphors explored. All images were viewed and all text read to look for potential pairings of subjects that created tension. All links were followed to the best of the ability of the researcher, leading to numerous sub-pages of the web site. [25]

4.3.3 Data Coding Examples.
The coding method of the five-level hierarchy described above was used to properly identify and classify the multiple metaphors found in these fourteen web sites.
The fourteen web sites used in the coding process are as follows in order of observation and case number (1-14): www.amazon.com, www.bigstar.com, www.comparenet.com, www.etrade.com, www.marthastewart.com, www.aa.com, http://carpoint.msn.com, http://expedia.msn.com, http://homeadvisor.msn.com, http://investor.msn.com, www.musicblvd.com, www.necx.com, www.quicken.com, and www.stockmaster.com. These fourteen cases were input into the Statistical Package for Social Sciences (SPSS) and first coded by type, where Type 1 is a shopping site and Type 2 a non-shopping site. Next, metaphors on each corporate web site were counted as they fit into the categories defined above. The total number of metaphors fitting each subclassification was input into the computer program.
Pictorial metaphors found were counted as the second variable input into SPSS. An example of a pictorial metaphor can be found at www.amazon.com. The pictorial icon image, , presents a shopping cart, but no accompanying words for the viewer to read. Thus, the web viewer must look at this virtual shopping cart and pair this image with their mental idea of a real-world shopping cart. The image is clickable and leads the web surfer to the contents of the virtual shopping basket in this on-line store. Therefore, the image is coded as a pictorial, clickable, working, virtual metaphor because the graphic image, when clicked, leads the viewer to the second subject of the metaphor, the contents of the shopping cart of the on-line consumer.
Verbal metaphors were also found in the web sites. To use a similar example, www.bigstar.com also allows viewers to purchase items on-line and put items in a shopping basket. However, no image is used to denote such a metaphor. Only words convey this virtual shopping basket, as shown on the web site by this clickable phrase, Shopping Basket. The text-only shopping basket was coded as a verbal metaphor that is clickable, working, and virtual since the act of clicking on the phrase leads the consumer to view the contents of the on-line shopping basket.
In the same vein of shopping, a verbo-pictorial example was found at www.marthastewart.com, depicting the verbo-pictorial metaphor . The image of a basket paired with the words, "view basket," aids the web surfer to comprehend the metaphor. When clicked, this green rectangle allows the web surfer to view the contents of their shopping basket in the Martha Stewart on-line store. This verbo-pictorial metaphor was thus coded as clickable, working, and virtual as well.
Non-clickable metaphors were found where the first subject of the metaphor was not linked to another web page and thus was not a clickable image or phrase. When the mouse was pointed at the object or phrase, the pointer did not become the "hand" icon that denotes a hyperlink in the body of the web page. Therefore, when the image or phrase was clicked upon, nothing happened. An example of this is found at www.bigstar.com, where the pictorial metaphor, , is non-clickable, but still denotes the "BigStar’s Big 10" movie choices.
Non-working metaphors were also identified where, when clicked upon, did not lead the web surfer to the second subject of the metaphor. On occasion, clicking on the first subject of the metaphor did load another web page, but produced a confusing and unrelated web page that did not provide the viewer with the second subject of the metaphor. For example, the verbo-pictorial metaphor, symbolic for e-mail, used at www.amazon.com, is shown as . Clicking on this combination of words and images does not lead the viewer to read or check his mail or e-mail, but only to fill out a form to request book reviews via e-mail from the Amazon book company. The clickable image does not present the web surfer with the second subject of the metaphor, and is thus coded non-working.
Classifications or groupings of online metaphors that arose such as entryways, directional, and searching were also observed. A searching example was located at http://investor.msn.com. When clicking on the hyperlink text, Finder, the web surfer loaded a page that would allow them to search a database of over 16,000 stocks and funds. This metaphor’s first subject was clickable text, which was coded as a verbal metaphor. However, when the second subject appears on the linked web page, a graphic image is paired with the word "Finder": . This image of binoculars represents the web surfer looking for information or details about the stocks and funds available at http://investor.msn.com. However, it is still a verbal metaphor since the primary subject was only text and no image accompanied it. This metaphor was classified as a searching type of verbal, clickable, working metaphor. [26]


II. Presentation of the sport discourse and football commentaries in the English and Ukrainian languages on a Web-site

1. General organization of a web-site

The web is becoming an integral part of our working world. You cannot spit anymore these days without hitting a URL. In a very short time span, the web has revolutionized the way we access information, education, business, entertainment. It has created industries where there were none before.
Being able to develop information on the web might be a job skill, a class requirement, a business necessity, or a personal interest. Unlike any other previous medium, the ability to "write" HTML allows you to potentially connect with millions of other people, as your own self-publisher.
The website (alternatively, Web site or web site) is a collection of Web pages, images, videos and other digital assets that is hosted on one or several Web server(s), usually accessible via the Internet (cell phone or a LAN also).A Web page is a document, typically written in HTML, that is almost always accessible via HTTP, a protocol that transfers information from the Web server to display in the user’s Web browser. All publicly accessible websites are seen collectively as constituting the "World Wide Web" (www).
The pages of websites can usually be accessed from a common root URL called the homepage, and usually reside on the same physical server. The URLs of the pages organize them into a hierarchy, although the hyperlinks between them control how the reader perceives the overall structure and how the traffic flows between the different parts of the sites.
Some websites require a subscription to access some or all of their content. Examples of subscription sites include many business sites, parts of many news sites, academic journal sites, gaming sites, message boards, Web-based e-mail, services, social networking website, and sites providing real-time stock market data Organized by function a website may be: a personal, commercial, government, non-profit organization website.
It could be the work of an individual, a business or other organization and is typically dedicated to some particular topic or purpose. Any website can contain a hyperlink to any other website, so the distinction between individual sites, as perceived by the user, may sometimes be blurred [2].
A website is hosted on a computer system known as a web server, also called an HTTP server, and these terms can also refer to the software that runs on these system and that retrieves and delivers the Web pages in response to requests from the website users. Apache is the most commonly used Web server software (according to Netcraft statistics) and Microsoft's Internet Information Server (IIS) is also commonly used.
Websites are written in, or dynamically converted to, HTML (Hyper Text Markup Language) and are accessed using a software program called a Web browser, also known as a HTTP client. Web pages can be viewed or otherwise accessed from a range of computer-based and Internet-enabled devices of various sizes, including desktop computers, laptop computers, PDAs and cell phones. [1]

2. Introduction to HTML

HTML, an initialism of HyperText Markup Language, is the predominant markup language for Web pages. It provides a means to describe the structure of text-based information in a document — by denoting certain text as links, headings, paragraphs, lists, and so on — and to supplement that text with interactive forms, embedded images, and other objects. HTML is written in the form of tags, surrounded by angle brackets. HTML can also describe, to some degree, the appearance and semantics of a document, and can include embedded scripting language code (such as JavaScript) which can affect the behavior of Web browsers and other HTML processors.
In 1980, physicist Tim Berners-Lee, who was an independent contractor at CERN, proposed and prototyped ENQUIRE, a system for CERN researchers to use and share documents. In 1989, Berners-Lee and CERN data systems engineer Robert Cailliau each submitted separate proposals for an Internet-based hypertext system providing similar functionality. The following year, they collaborated on a joint proposal, the WorldWideWeb (W3) project, which was accepted by CERN.
The first publicly available description of HTML was a document called HTML Tags, first mentioned on the Internet by Berners-Lee in late 1991. It describes 22 elements comprising the initial, relatively simple design of HTML. Thirteen of these elements still exist in HTML 4.
Berners-Lee considered HTML to be, at the time, an application of SGML, but it was not formally defined as such until the mid-1993 publication, by the IETF, of the first proposal for an HTML specification: Berners-Lee and Dan Connolly's "Hypertext Markup Language (HTML)" Internet-Draft, which included an SGML Document Type Definition to define the grammar. The draft expired after six months, but was notable for its acknowledgment of the NCSA Mosaic browser's custom tag for embedding in-line images, reflecting the IETF's philosophy of basing standards on successful prototypes. Similarly, Dave Raggett's competing Internet-Draft, "HTML+ (Hypertext Markup Format)", from late 1993, suggested standardizing already-implemented features like tables and fill-out forms.
After the HTML and HTML+ drafts expired in early 1994, the IETF created an HTML Working Group, which in 1995 completed "HTML 2.0", the first HTML specification intended to be treated as a standard against which future implementations should be based. Published as Request for Comments 1866, HTML 2.0 included ideas from the HTML and HTML+ drafts. There was no "HTML 1.0"; the 2.0 designation was intended to distinguish the new edition from previous drafts.
Further development under the auspices of the IETF was stalled by competing interests. Since 1996, the HTML specifications have been maintained, with input from commercial software vendors, by the World Wide Web Consortium (W3C). However, in 2000, HTML also became an international standard (ISO/IEC 15445:2000). The last HTML specification published by the W3C is the HTML 4.01 Recommendation, published in late 1999. Its issues and errors were last acknowledged by errata published in 2001. [3]

3. Basic HTML elements

In computing, an HTML element indicates structure in an HTML document and a way of hierarchically arranging content. More specifically, an HTML element is an SGML element that meets the requirements of one or more of the HTML Document Type Definitions (DTDs). These elements have properties: both attributes and content, as specified (both allowable and required) according to the appropriate HTML DTD (for example, the HTML 4.01 strict DTD). Elements may represent headings, paragraphs, hypertext links, lists, embedded media, and a variety of other structures.



Syntactically HTML elements are constructed with:
· a start tag marking the beginning of an element
· any number of attributes (and their associated values)
· some amount of content (characters and other elements)
· an end tag
Many HTML elements include attributes in their start tags, defining desired behavior or indicating additional element properties. The end tag is optional for many elements; in a minimal case, an empty element has no content and requires no end tag. There are a few elements that are not part of any official DTDs, yet are supported by some browsers and used by some web pages. Such elements may be ignored or displayed improperly on browsers not supporting them.
Informally, HTML elements are sometimes referred to as "tags" (an example of synecdoche), though many prefer the term tag strictly in reference to the semantic structures delimiting the start and end of an element.

Head elements
<title>…</title>

Define a document title. This element is required in every HTML and XHTML document. Different user agents may make use of the title in different ways. For example:
· Web browsers usually display it in a window's title bar when the window is open, and in the task bar when the window is minimized.
· It may become the default filename when saving the page.
· Search engines' Web crawlers may pay particular attention to the words used in the title.
The title element must not contain any nested tags (that is, it cannot contain any other elements). Only one title element is permitted in a document.
<base>
Specifies a base URL for all relative href and other links in the document. Must appear before any element that refers to an external resource. HTML permits only one base element for each document. The base element has attributes, but no contents.
<link>
Specifies links to other documents, such as "previous" and "next" links, or alternate versions.
<script>…</script>
Used to add JavaScript or other scripts to the document. The script code may be typed literally between the script tags or may be given in a separate resource whose URL is specified with the script element's optional src attribute.
<style>…</style>
Specifies a style for the document, usually in the form <style type="text/css">…</style>
<object>…</object>
Used for including generic objects within the document header. Though rarely used within a head element, it could potentially be used to extract foreign data and associate it with the current document.
<meta>
Can be used to specify additional metadata about a document, such as its author, publication date, expiration date, page description, keywords, or other information not provided through the other header elements and attributes. Because of their generic nature, meta elements specify associative key-value pairs.
In the general form, a meta element specifies name and associated content attributes describing aspects of the HTML page. To prevent possible ambiguity, an optional third attribute, scheme, may be supplied to specify a semantic framework that defines the meaning of the key and its value: for example, <meta name="foo" content="bar" scheme="DC">
[bookmark: Inline_elements]Inline elements
Inline elements cannot be placed directly inside the body element; they must be wholly nested within block-level elements (see Block elements, below).
[bookmark: General_phrase_elements]
General phrase elements
<em>…</em>

Emphasis (conventionally displayed in italics)

<strong>…</strong>

strong emphasis (conventionally displayed bold). An oral user agent may use different voices for emphasis.

<q>…</q>

A quotation containing only inline elements (for quotations containing block level elements see blockquote below).

<cite>…</cite>

A citation. Reference for a quote or statement in the document.

<dfn>…</dfn>

Defining first instance of a term

<abbr>…</abbr>

Contains an abbreviation, like abbr.

<acronym>…</acronym>

Similar to the abbr element, but contains an acronym, like HTML.
[bookmark: Computer_code_phrase_elements]Computer code phrase elements
These elements are useful primarily for documenting computer code development and user interaction through differentiation of source code (<code>), source code variables (<var>), user input (<kbd>), and terminal output (<samp>).

<code>…</code>

A code snippet. Conventionally rendered in a monospace font: Code snippet.

<samp>…</samp>

Sample output (from a program or script)

<kbd>…</kbd>

Keyboard - text to be entered by the user

<var>…</var>
Variable
[bookmark: Special_inline_elements]Special inline elements
<del>…</del>

Deleted text. Typically rendered as a strikethrough:

<ins>…</ins>

Inserted text.
[bookmark: Links_and_anchors]
Links and anchors
<a>…</a>

Creates an element that becomes a hyperlink with the href (hypertext reference) attribute set to a URL; additionally the attribute title may be set to a hover box text, some informative text about the link:

<ahref="URL"title="additional information">link text</a>
[bookmark: Images_and_objects]Images and objects
<img>

Includes an image with the src attribute. The required attribute provides alternative text in case the image cannot be displayed. Alt is intended as alternative text, although Microsoft Internet Explorer renders it as a tooltip if no title is given; the title attribute is the tooltip text. It was proposed by Marc Andreessen.

<br> or <br />

Specifies a line-break.

<map>…</map>

Specifies a client-side image map.

<area>

Specifies an area in the map.

<object>…</object>

Includes an object in the page of the type specified by the type attribute. This may be in any MIME-type the Web browser understands, such as an embedded page, code to be handled by a plug-in such as Flash, a Java applet, a sound file, etc.
[bookmark: Span_element]
Span element
<span>…</span>

Creates an inline logical division.
[bookmark: Block_elements]Block elements
Many HTML elements are designed for altering the semantic structure or meaning of a document. Some are block-level, but most are inline and can be included in the normal flow of text.
[bookmark: General_block_elements]General block elements <p>…</p>
Creates a paragraph, perhaps the most common block level element. The closing tag is not required in HTML, however is required for XHTML.

<blockquote>…</blockquote>

Contains quoted material when the quotation itself includes block level elements (for instance, quoting several paragraphs).

<hr>

Inserts a horizontal rule.
[bookmark: Headings]Headings

<h1>…</h1> <h2>…</h2> <h3>…</h3> <h4>…</h4> <h5>…</h5> <h6>…</h6>

Section headings at different levels. Use <h1> for the highest-level heading (the major sections), <h2> for the next level down (sub-section), <h3> for a level below that, and so on. The lowest level heading is <h6>.
[bookmark: Lists]
Lists
<dl>…</dl>

Creates a definition list (consisting of definition terms paired with definitions).

<dt>…</dt>

Creates a definition term.

<dd>…</dd>
Creates a definition.

<ol>…</ol> and <ul>…</ul>

Creates an ordered (enumerated) or unordered (bulleted) list.

<li>…</li>

Creates a list item in ordered and unordered lists.
[bookmark: Tables]
Tables
<table>…</table>

Creates a table

<tr>…</tr>

Creates a row in the table.

<th>…</th>


Creates a table header cell within a row or a column; contents are conventionally displayed bold and centered.

<td>…</td>

Creates a table data cell within a row.

<colgroup>…</colgroup>

Specifies a column group in a table.

<col>

Specifies attributes for an entire column in a table.

<caption>…</caption>

Specifies a caption for the entire table.

<thead>…</thead>

Specifies the header part of a table.

<tbody>…</tbody>

Specifies the main part of a table.

<tfoot>…</tfoot>


Specifies the footer part of a table.
[bookmark: Forms]Forms
These elements can be combined into a form or used separately as user-interface controls. Combined with a first-class javascript engine, these controls provide support for rich user interfaces. HTML specifies the elements that make up a form, and the method by which it will be submitted. However, some form of script either server-side or client side must be used to process the user's input once it is submitted.

<formaction="url">…</form>

Creates a form.

<selectname="xyz">…</select>

Create a selection list, from which the user can select a single option. May be rendered as a dropdown list.

<optionvalue="x">

Creates an item in a select list.

<inputtype="checkbox">

Creates a checkbox. Can be checked or unchecked.

<inputtype="radio">

Creates a radio button.

<inputtype="button">

Creates a general-purpose button.

<inputtype="submit">

Creates a submit button.

<inputtype="image">

Creates a button using an image.

<inputtype="reset">

Creates a reset button for resetting the form to default values.

<inputtype="file">

Creates a file select

<inputtype="hidden">

Is not visible in the rendered page, but allows a designer to maintain a copy of something that needs to be submitted to the server as part of the form.

<labelfor="id">…</label>

Creates a label for a form input (e.g. radio button).

<textarearows="8">…</textarea>

Create a multiple-line text area, the size of which is specified by cols and rows attributes. Text in between the tags appears in the text area when the page is loaded.
[bookmark: Other_containers]
Other containers
<div>…</div>

Creates a block logical division.

<pre>…</pre>

Creates pre-formatted text.

<address>…</address>

Used to mark up contact information like address for the document or a section of it.

<iframe>…</iframe>

Includes another HTML document in the page.
The <iframe> tag must be closed by </iframe>. Otherwise the content after the <iframe> tag will be taken as alternative text to be displayed when the browser has no iframe support.
[bookmark: Frames]Frames
An HTML document may contain a header and a body or a header and a frameset, but not both. For frames the Frames DTD must be used.

<frameset>…</frameset>
Delimit the frameset. The frames layout is given by comma separated lists in the rows and cols attributes.

<frame>…</frame>

Delimit a single frame, or region, within the frameset. A different document linked with the src attribute appears inside.

<noframes>…</noframes>

Contains a normal <body> element with child elements that will appear in web browsers that don't support frames.
[bookmark: Presentational_markup][bookmark: Official_presentational_markup]Official presentational markup

<b>…</b>

Use boldface type. Equivalent CSS: {font-weight: bold}

<i>…</i>

Use italic type. Equivalent CSS: {font-style: italic}

<big>…</big>

Creates bigger text. Equivalent CSS: {font-size: larger}.

<small>…</small>


Creates smaller text. Equivalent CSS: {font-size: smaller}

<tt>…</tt>

Use a typewriter-like, also known as teletype font. Equivalent CSS: {font-family: monospace} [1, p. 46-55]

4. Main types of HTML editors

An HTML editor is a software application for creating web pages. Although the HTML markup of a web page can be written with any text editor, specialized HTML editors can offer convenience and added functionality. For example, many HTML editors work not only with HTML, but also with related technologies such as CSS, XML and JavaScript or ECMAScript. In some cases they also manage communication with remote web servers via FTP and WebDAV, and version management systems such as CVS or Subversion.
Text editors
Plain text editors may be used to produce webpages.
The following are some commonly used text editors:

	· EditPlus
· Emacs
· gedit
· jEdit
· Kate
· nano
· Notepad 
	· TextEdit
· UltraEdit
· Crimson Editor
· vi (Sun Microsystems)
· Vim
· Notepad++
· TextMate 


[bookmark: Text-based_HTML_editors]
Text-based HTML editors
Text-based HTML editors evolved from basic text editors, but include additional tools specifically geared toward handling code.
	· Adobe Dreamweaver
· Adobe HomeSite
· Alleycode HTML Editor
· Aptana
· Arachnophilia
· BBEdit
· BestAddress HTML Editor
· BlueFish
· CoffeeCup HTML Editor
· Eclipse with the Web Tools Platform
· EditPlus
· EmEditor
· Evrsoft 1st Page 
	· HTML-Kit
· Microsoft Expression Web
· Microsoft Visual Web Developer
· Notepad++
· NoteTab
· PSPad
· Quanta Plus
· SCREEM
· Siteaid
· Smultron
· skEdit
· TextMate
· TextPad
· TextWrangler
· TopStyle


[bookmark: Word_processors]
Word processors
While word processors are not ostensibly HTML editors, many of the major products are capable of exporting document layouts in HTML format. This offers the ease of use of a word processor, similar to a WYSIWYG product (see below), but has some of the same end product limitations.
· AbiWord
· AppleWorks
· Microsoft Word
· OpenOffice.org Writer
· WordPerfect
[bookmark: WYSIWYG_editors]WYSIWYG editors
WYSIWYG (What You See Is What You Get) code generators offer speed and ease of use.
Many of these editors do not require any knowledge of the programming languages generated by the software.
Some of these editors store pages in a proprietary format and then export them as HTML (possibly along with other formats); the user would continue to maintain the website by working with the files in the proprietary format and re-exporting them. Other, generally simpler WYSIWYG editors are designed to work directly with HTML files.
Although the term WYSIWYG is often used for these editors, they are generally not truly WYSIWYG (see Difficulties in achieving WYSIWYG).

	· Adobe
· Contribute "Dreamweaver Lite"
· Dreamweaver
· Altova StyleVision
· Amaya
· Aptana
· Bluevoda
· Create
· Evrsoft 1st Page

	· Freeway
· iWeb
· KompoZer
· Media Lab SiteGrinder
· Microsoft
· Expression Web
· Visual Studio / ASP.NET Web Matrix
· NetObjects Fusion 
	· Opera Dragonfly
· Quanta Plus
· RapidWeaver
· Sandvox
· SeaMonker Composer
· WorldWideWeb
· Yahoo SiteBuilder[1] 


[bookmark: WYSIWYM_editors]
WYSIWYM editors
WYSIWYM (what you see is what you mean) is an alternative paradigm to WYSIWYG, in which the focus is on the semantic structure of the document rather than on the presentation. These editors produce more logically structured markup than is typical of WYSIWYG editors, while retaining the advantage in ease of use over hand-coding using a text editor.
· WYMeditor
[bookmark: Discontinued_editors]Discontinued editors
Editors that have been discontinued, but may be in common use
· Adobe GoLive - Now discontinued. Replaced by Adobe Dreamweaver.
· AOLpress - Now discontinued.
· Adobe PageMill - Now discontinued. Replaced by Adobe GoLive.
· Microsoft FrontPage - Now discontinued. Replaced by Microsoft Expression Web
· Netscape Composer; Mozilla Composer - Not updated or supported. Replaced by Nvu then KompoZer, or SeaMonkey Composer
· Nvu; Developer Daniel Glazman is working on replacement, tentatively called Mozilla Composer; a community-driven WYSIWYG HTML editor fork, KompoZer, maintains Nvu codebase and fixes bugs until a successor to Nvu is released.
· HotDog - essentially discontinued with no updates since 2003
· HoTMetaL - Replaced by XMeTaL, a commercial XML editor. [2, p.12-13]

5. Dreamweaver as an expert tool in website creation

In my diploma paper I used such HTML editor as Dreamweaver. Adobe Dreamweaver is a web development application originally created by Allaire Systems, which was acquired in, approximately, 1998 by Macromedia and is now owned by Adobe Systems, which acquired Macromedia in 2005.
Dreamweaver is available for both Mac and Windows operating systems. Recent versions have incorporated support for web technologies such as CSS, JavaScript, and various server-side scripting languages and frameworks including ASP.NET, ColdFusion, JavaServer Pages, and PHP.
As a WYSIWYG Presto-based editor, Dreamweaver can hide the HTML code details of pages from the user, making it possible for non-coders to create web pages and sites. One criticism of this approach is that it can produce HTML pages whose file size and amount of HTML code is larger than an optimally hand-coded page would be, which can cause web browsers to perform poorly. This can be particularly true because the application makes it very easy to create table-based layouts. In addition, some web site developers have criticized. Dreamweaver in the past for producing code that often does not comply with W3C standards, though recent versions have been more compliant. However, Adobe has increased the support for CSS and other ways to lay out a page without tables in later versions of the application, with the ability to convert tables to layers and vice versa.
Dreamweaver allows users to preview websites in many browsers, provided that they are installed on their computer. It also has some site management tools, such as the ability to find and replace lines of text or code by whatever parameters specified across the entire site, and a templatisation feature for creating multiple pages with similar structures.
Dreamweaver can use "Extensions" – small programs, which any web developer can write (usually in HTML and JavaScript). Extensions provide added functionality to the software for whoever wants to download and install them. Dreamweaver is supported by a large community of extension developers who make extensions available (both commercial and free) for most web development tasks from simple rollover effects to full-featured shopping carts.
Like other HTML editors, Dreamweaver edits files locally, then uploads all edited files to the remote web server using FTP or SFTP.
Dreamweaver can display a document in three ways: in Design view, in Code view, and in a split view that shows both the design and code. By default, Dreamweaver displays the Document window in Design view.
In addition, I can work with the Dreamweaver Design view in two different ways—in Layout view and Standard view. In Layout view I can design a page layout, insert graphics, text, and other media; in Standard view, in addition to inserting graphics text and media, I can also insert layers, create frame documents, create tables, and apply other changes to your page—options that aren’t available in Layout view.
There are different versions of this program: Dreamweaver 1.0, Dreamweaver 1.2, Dreamweaver 2.0, Dreamweaver 3.0, Dreamweaver UltraDev 1.0, Dreamweaver 4.0, Dreamweaver UltraDev 4.0, Dreamweaver MX [Internal version number: 6.0], Dreamweaver MX 2004, Dreamweaver 8, Dreamweaver CS3, Dreamweaver CS4.
Dreamweaver CS3
In this paper was applied the version of Dreamweaver, CS3. From start to finish with Adobe Dreamweaver CS3 software you can make, develop and maintain design of websites and web applications quickly and easily. Built for both designers and developers, Dreamweaver CS3 offers the choice of working in an intuitive visual layout interface or a streamlined coding environment. Intelligent integration with Adobe Photoshop CS3, Adobe Illustrator CS3, Adobe Fireworks CS3, Adobe Flash CS3 Professional, and Adobe Contribute CS3 software ensures efficient workflow across your favourite tools [36].
Dreamweaver operates based upon the concept of a web site. When the program was opened for the first time, Dreamweaver makes me define a site. This helps to keep all files organized. With a simple web site, we will just need to keep a few files within a file folder. However, it is best to plan this out before we start, since folder maintenance will help greatly as our site grows and we start linking to other web pages and adding graphics.
So, let us dwell carefully upon the instructions of this project development:
· Click the item on the menu ‘Manage Sites’;
· Open the ‘Site Files’ window;
· In the window that opens, choose ‘Define Sites as shown below’;
· Choose ‘New’ in the window that pops up;
· Select the Advanced tab in the Site Definition window;
· Put a desirable title ‘Typology of discourse’ under request ‘What would you like, to name your site?’ (Figure 1.);
· The title changes rapidly into ‘Site Definition for Typology of discourse’;
· Click the bottom ‘Next’ on the window of dialog;
· Choose ’No, I do not want to use a server technology’ to the question ‘Do you want to work with a server technology such as ColdFusion, ASP.NET, ASP, JSP, or PHP?’ > ‘Next’ >;
· To the question ‘How do you want to work with your files during development?’ choose button ‘Edit local copies on my machine, then upload to server when ready (recommended)’;
· Dreamweaver will now ask for name of the site and where it is on your hard drive. For now, just enter the Local Info. Enter the relevant information. Make sure we enter the location of the Tutorial folder on our computer and not what is shown below > ‘Next’ >;
· Pick ‘None’ in the list that is given after the request ‘How do you connect to your remote server?’ > ‘Next’>;
· Now there is a summary about site in a window ‘Site Definition for Typology of discourse’ there > ‘Done’>;
· When the window ‘Site Definition for Typology of discourse’ is closed return to the one, which is called ‘Manage Sites...’, where the title (‘Magic of the names’) of the website appeared;
· Choose ‘Done’ and this way all windows will be closed
[bookmark: 0.1_graphic06]Dreamweaver does not include any font or size attributes from the text editor. That is why Word HTML was imported into Dreamweaver:
· Choose ‘File’ > ‘Import’ > ‘Import Word HTML’ (we can import other file formats here as well);
· Open the ‘blurb.html’ included with the tutorial file. This HTML file was saved using Word’s Save as HTML feature;
· Leave the default selections as they are and click ‘OK’ in the window that opens;
· A new Web page window opens with the description text which retains the font and size attributes;
· Highlight the text and copy it. Your Web page window is now hidden behind this new one;
· Close the new Web window without saving;
· Highlight the text that we pasted before, and choose Edit > Paste;
· Clean Up Word HTML.
When a document is saved using MS Word’s Save as HTML feature (Figure 2.), Word imbeds many tags into the document that some programs will not use. To remove these tags, choose Commands > Clean up Word HTML.
Now we have a basic Web page. To preview your Web page in a browser, choose File > Preview in Browser > [Browser]. It is best to preview page in several browsers (for example, Netscape and Internet Explorer). It may look different with differentbrowsers.
Dreamweaver offers complete control over HTML code colouring and formatting. For example, under ‘Edit’ > ‘Preferences’ > ‘Code Colors’, we can specify the colours to use when displaying HTML code. We may specify separate colours for text, comments, tags, reserved JavaScript keywords, JavaScript function names, and JavaScript string literals. We have infinite control over the colour applied to each tag and its attributes. For example, we can use one colour for <img> tags, another colour for <img> attributes, and a third colour for <a> tags
Furthermore, we can control HTML formatting under ‘Edit’ > ‘Preferences’ > ‘Code Format’. These preferences allow precise control over indentation (using either tabs or spaces), line wrapping, and line breaks [34].
[bookmark: 0.1_graphic09]Discovering visual CSS tools it became obvious that these tools make it easy to view, edit, and move styles within and between files, as well as see how our changes will affect the design 


Conclusions

Advertising in Web resources has been observed in the given research. First of all the specific features of the main approaches of the persuasion have been described. There has been investigated that different techniques and methods of persuasion are an inalienable and main part of advertising. Besides in practical part I have made the Web-site containing not only information about persuasion, banners, metaphors and other crucial parts of advertisements but also some interesting facts that have not been included in the diploma paper. This research has been based upon the books and works of famous researchers, journals and papers related to the theme, internet sources, examples of widely-known banner makers.
Firstly, the theoretical linguistic background on the theme has been provided in the first part of the paper. Discourse studies, the use of the implication in the discourse of commercial English advertising and different types of the persuasion have been described.
Secondly, the characteristic features of the advertising have been investigated. I have underlined that the main aim of the advertising is to serve one or another necessities: income of the corporations, collaboration with other companies, personal necessities, maintenance of relationships with other firms, persuasion other to operate in some way, realization of lordship over other people, display of creative nature and imagination.
Thirdly, the similar and distinctive features of the banners and copy testing banners advrtisements have been analyzed. I have investigated that both types of the advertisings can be very useful in achieving their aim. A good banner must have something that makes it memorable enough to stay in public consciousness for years afterwards.
In the fourth part I have investigated the use of metaphors in advertising. The study of metaphors in advertising, different types of on-line metaphor advertisements, methodology of the metaphor usage have been overviewed in this chapter of the paper..
This research has disclosed plenty of interesting and useful information about advertising and peculiarities of its usage.For examples, I have observed that in the majority sites the virtual metaphors are more useful than visual, but in some sites virtual metaphors can’t be well recognized.
Thus the most significant conclusion can be done that on-line advertisements is becoming more and more popular in the media. Right now web advertisiments are the second in the world type of advertising according to their influence on people’s decision.
The second main part of this paper has been the website development. Dreamweaver is the tool, which was chosen for its realization. Comprehensive in-product tutorials, reference content and instructional templates made it easy to expand one’s skill set and adopt the latest technologies, Dreamweaver helped to realize our second part of the work.
This tool has helped me to facilitate my desire to introduce the web-site where it will be possible to find all needed information about advertising and its use in the Web.
Being Adobe’s software, Dreamweaver has features for both the beginning and advanced web page creator. Dreamweaver integrated many aspects of Web development, including page creation, site management, and web server tools, giving the user a good perspective of an entire web site. That is why I have got a website of comprehensive structure and beautiful interface.
In the practical part the Web-site has been supplied with main theoretical items of my diploma paper, with links where it is possible to watch football and with main information about commentators and their commentaries.
So, I would like to conclude that on-line advertisements has become an inevitable part of everyday life.
[bookmark: _GoBack]
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